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Restoration and Protection Screening (RPS) Map Service Guide

1 Introduction

The Restoration and Protection Screening (RPS) Indicator Database is a free, publicly available dataset of
watershed indicators developed by the U.S. Environmental Protection Agency to assist resource
managers, citizens and other users with strategic planning of priority waters and watersheds. The
indicators in the RPS Indicator Database measure a wide variety of watershed characteristics (e.g.,
percent forest cover, number of impaired waters or area of protected lands) for roughly 83,000 12-digit
Hydrologic Unit (HUC12) subwatersheds across the contiguous United States. Indicator data can be
accessed from the RPS Tool by downloading Microsoft Excel or ESRI geodatabase files from the RPS
website or through the RPS Map Service.

Map services provide users with access to geospatial data without needing to download and store the
dataset on a laptop or desktop computer. Map services are particularly useful for web-based
applications, such as mapping or data analysis tools. These applications can be programmed to retrieve
targeted pieces of a dataset using map services and then format and display the data according to the
needs of users.

The following sections are intended to support users interested in accessing indicator data through the
RPS Map Service:

e Section 2 - The Basics provides basic information about the RPS Map Service.

e Section 3 - Getting Started: Viewing the HUC12 Layers is primarily intended for beginner-level users
of map services and provides step-by-step instructions for viewing maps of indicator data using
ArcGIS Online or ArcGIS Pro software.

e Section 4 - Querying the RPS Map Service is primarily intended for application developers and
contains examples of how to query the service to retrieve indicator data.

2 The Basics

The RPS Map Service provides access to a database of indicators for HUC12 subwatersheds in the
contiguous United States. HUC12 boundaries are based on topographic drainage patterns and are
delineated by the US Geological Survey and Natural Resources Conservation Service as part of the
national Watershed Boundary Dataset.! HUC12s average approximately 35 square miles in size. The RPS
Indicator Database contains indicator data for 82,915 HUC12s and uses the February 2015 version of
HUC12s produced for the EPA EnviroAtlas mapping tool.

The RPS Map Service is published on the EPA’s ArcGIS Server. The base URL for the service is:
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer. The RPS Map Service is comprised of
four items: the HUC12 Feature Layer,the Simplified HUC12 Feature Layer, the Indicator Data Table and
the Indicator Information Table. A diagram of these components is provided in Figure 1. Key
characteristics of each item are listed below.

1 Refer to the USGS Watershed Boundary Dataset website for additional background information on HUC12
subwatersheds.



https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer
https://edg.epa.gov/metadata/catalog/search/resource/details.page?uuid=%7BBA1041E9-02B6-40ED-8DB0-B1EEF68B6CA7%7D
https://edg.epa.gov/metadata/catalog/search/resource/details.page?uuid=%7BBA1041E9-02B6-40ED-8DB0-B1EEF68B6CA7%7D
https://www.epa.gov/enviroatlas
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer
https://www.usgs.gov/national-hydrography/watershed-boundary-dataset
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1. HUCI12 Feature Layer (https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0)

O

Includes polygons depicting HUC12 boundaries and an attribute table that stores indicator
values.

Each row of the attribute table contains indicator values for one HUC12. Different indicators
are stored in the table’s columns.

The layer name is “NHDPlusV2_HUC12” and the coordinate system is WGS 1984 Web
Mercator (Auxiliary Sphere), EPSG code 3857.

2. Simplified HUC12 Feature Layer (https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1)

O

Same as the HUC12 Feature Layer above except with simplified HUC12 polygon boundaries
to enable faster mapping within the Web RPS Tool or other applications.

The simplified HUC12 polygons have the same essential shape as polygons in the HUC12
Feature Layer but are generalized to remove detail along the HUC12 boundary.

This layer should only be used for creating maps to display data. It should not be used for
geospatial analysis. Use the HUC12 Feature Layer for geospatial analysis.

The layer name is “NHDPlusV2_HUC12_Simplified” and the coordinate system is WGS 1984
Web Mercator (Auxiliary Sphere), EPSG code 3857.

3. Indicator Data Table (https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2)

O

O

O

A standalone table of indicator values for HUC12s.
Contains the same data as the attribute table of the HUC12 Feature Layer.

The table name is “Indicator_Data”.

4. |Indicator Information Table (https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3)

O

A table of supplemental information for indicators, including the full name of each indicator,
category, subcategory and description.

The “Field_Name” column contains indicator names exactly as they are stored in the HUC12
Feature Layer and Indicator Data Table. Therefore, the “Field_Name” column can be used to
look up supplemental information for specific indicators of interest.

The table name is “Indicator_Info”.


https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3
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HUC12 Feature Layer B Simplified HUC12 Feature Layer

' (Layer Name = NHDPlusV2_HUC12) ' (Layer Name = NHDPlusV2_HUC12_Simplified)
contains HUC12 polygons and an contains HUC12 polygons with simplified
attribute table with indicator values for boundaries and an attribute table with

each HUC12 indicator values for each HUC12

- o VN

HUC12_TEXT FOREST_PCT_WS FOREST_DECIDUOUS_PCT_WS| FOREST_EVERGRN_PCT_WS I<_
010100020101 77.914245 5.930087 29.810915
010100020102 76.699201 16.125776 22.301464
010100020103 80.407811 10.086189 29.902543

Indicator Data Table (Table Name = Indicator_Data) - contains the same data as the HUC12
Feature Layer attribute table

HUC12_TEXT FOREST_PCT_WS FOREST_DECIDUOQUS_PCT_WS | FOREST_EVERGRN_PCT_WS |<_
010100020101 77.914245 5.930087 29.810915
010100020102 76.699201 16.125776 22.301464
010100020103 80.407811 10.086189 29.902543
n1n1nAN2n1n4 4 41408 14 n?Ena4 2R 441712
Indicator Information Table (Table Name = Indicator_Info) - contains supplemental information
for indicators
Category Subcategory Field_Name Indicator_Name Description
Ecological Forest Cover FOREST_PCT_WS % Forest in WS (2018) Percent of the HUC12 cla
Ecological Forest Cover FOREST_DECIDUOUS_PCT_WS | % Deciduous Forest in WS (2016) |Percent of the HUC12 cla
Ecological Forest Cover FOREST EVERGRN PCT WS |% Evergreen Forestin WS (2016) |Percent of the HUC12 cla
Ecological Forest Cover FOREST_M D(E‘_PCT_WS % Mixed Forest in WS (2016) Percent of the HUC12 cla
Emmlmmimml Cmrmmb N mcome cAREST AeT - OF Cmmmmb im LUST IARASN Plnemmmb md b LIS AT dm

Field_Names match the column names of the
HUC12 Feature Layer, Simplified HUC12 Feature
Layer, and Indicator Data Table

Figure 1. Diagram of elements in the RPS Map Service.
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3 Getting Started: Viewing the HUC12 Layers

3.1 Viewing the HUC12 Feature Layer and Simplified HUC12 Feature Layer with ArcGIS Online

This section is provided for beginner users of map services that may be interested in viewing the RPS
indicator data with ArcGIS Online and creating basic maps. Note that the ArcGIS Online Map Viewer
provides limited options to symbolize, filter, or otherwise interact with RPS indicator data. Desktop GIS
software, such as ArcGIS or QGIS, offers expanded options for creating maps using the RPS indicator
data. Section 3.2 of this guide describes how to add the HUC12 Feature Layer or Simplified HUC12
Feature Layer to ArcGIS Pro software.

3.1.1 How to Open the ArcGIS Online Map Viewer
Click the ArcGIS Online Map Viewer link at the top of the RPS Map Service landing page to open the
HUC12 Feature Layer and Simplified HUC12 Feature Layer in ArcGIS Online (Figure 2).

Home > services > OW > RPS (MapServer) API Reference

OW/RPS (MapServer)

View In: ArcGIS JavaScript | ArcGIS Online Map Viewer | ArcGIS Earth ArcGIS Pro

Service Description:
Map Name: Map
Legend

All Layers and Tables
Dynamic Legend

Dynamic All Layers

Figure 2. Link to the ArcGIS Online Map Viewer on the RPS Map Service service landing page.

The Layers pane of the Map Viewer displays the HUC12 Feature Layer and Simplified HUC12 Feature
Layer (Figure 3). The layer names are “NHDPlusV2 HUC12” and “NHDPIusV2 HUC12_Simplified”. The
Indicator Information Table and the Indicator Data Table are also shown in the Tables pane (Figure 3).


https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer
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Figure 3. Initial view of the HUC12 Feature Layer in the ArcGIS Online Map Viewer with the Layers
pane (top) and Tables pane (bottom) highlighted.
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3.1.2 How to Create an Indicator Map in the ArcGIS Online Map Viewer
The steps below can be used to create a basic map of indicator data within the ArcGIS Online Map

Viewer.
1. To open the symbology menu, first click on the layer that —
you would like to map in the Layers pane (either the -
HUC12 Feature Layer or Simplified HUC12 Feature Layer;
see Figure 3). ]
—
Then click the Styles icon on the right side of the map.
Y
2. On the Styles menu, click the ‘Field’ button to choose an @
indicator to map.
Choose attributes
Choase which fields you want to map.
The order will affect how some styles are
applied.
> + Field + Expression
3. Alist of indicators will display. Choose an indicator to Select fields “
map and click the ‘Add’ button.
| Q  AG_P X =
AG_PCT_HUC12 @
Note: a description of the available indicators can be [ |AG-PCT_SLP10_HUC12 @
viewed by opening the Indicator Information Table from 1 | per strz0 Huciz o
the Tables pane. This example uses the percent
agricultural cover indicator (‘AG_PCT_HUC12’).
4. Pick a style. Styles determine the method for visualizing ®
the indicator data. The ‘Counts and Amounts (color)’
option is typically best-suited for indicator data. Pick a style
These styles are good for visualizing a
single numeric field.
5. Click the ‘Style options’ button to customize the
color scheme and select other display options. Or
skip this step to use the default color scheme. E—
Counts and Amounts @
(color)
Theme
High to low v
6. Click “Done” to view a national map of the selected > Style options |

indicator.
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Figure 4 contains an example map created from the steps described above. The map displays values of
the percent agricultural cover indicator. Refer to the ArcGIS Online help page for style settings for more
information on customizing the display of a map.

Loke
Superior

Q Gulf of .

Mayirn

Figure 4. Example map of percent agricultural cover in HUC12s created in the ArcGIS Online Map
Viewer with the RPS Map Service.


https://doc.arcgis.com/en/arcgis-online/create-maps/style-numbers-mv.htm
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3.1.3 How to Filter HUC12s in the ArcGIS Online Map Viewer
The filter option within the ArcGIS Online Map Viewer can be used to display a subset of HUC12s that
meet one or more user-defined selection criteria. To apply a filter, follow the instructions below.

1. Inthe Settings menu on the right, click the Filter icon to
display the filter menu. Then click ‘Add New’.

!

+ Add new

< | &7

2. Drop-down menus will display for creating a filter
. . . . NHDPlusvV2_HUC12
expression. In this example, the map will be filtered to only

display HUC12s that are located in Arkansas.

Filter X
The top drop-down menu contains a list of fields in the
attribute table of the HUC12 Feature Layer. Type or select
o ] Show features where Clear all
“STATES_ALL”. This field lists the states that each HUC12
intersects using 2-letter state abbreviations.
Condition

The middle drop-down menu contains logical expressions
for your filter. Select ‘contains the text’ to choose HUC12s HUC12 TEXT
that contain a specific state abbreviation.

tains the text v
In the bottom text box you will type the state abbreviation contains The e

to use for filtering. Enter ‘AR’ to only display HUC12sin _J AR
Arkansas.

3. Click the ‘Save’ button at the bottom of the Filter menu.

With these settings, only HUC12s that intersect Arkansas {

will be displayed on the map.

Figure 5 contains an example filtered map created from the steps described above. The map displays
values of percent agricultural cover in Arkansas HUC12s. The filter menu can also be applied to only
display HUC12s that meet a numeric expression, such as HUC12s with greater than 25% agricultural
cover. Refer to the ArcGIS Online help page for applying filters for additional details on using the filter
menu.



https://doc.arcgis.com/en/arcgis-online/create-maps/apply-filters-mv.htm
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Figure 5. Example map of percent agricultural cover in Arkansas HUC12s created in the ArcGIS Online

Map Viewer with the RPS Map Service.
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3.2 Viewing the HUC12 Feature Layer in ArcGIS Pro

ArcGIS Pro software provides users with additional options for creating custom indicator maps. This
section describes steps for adding the RPS Map Service to ArcGIS Pro. Depending on internet connection
speed, users may experience long loading times when opening and viewing the HUC12 Feature Layer. In
these cases, users may instead view the Simplified HUC12 Feature Layer, or download a geodatabase of
HUC12 polygons and data tables from the RPS website for use in ArcGIS Pro or other GIS software.

1. In ArcGIS Pro, open the Catalog pane and
select the Project tab. Right-click anywhere
in the grey pane and select “New” > “New
Server” > “New ArcGIS Server”.

Z E!;/ New Mobile Style

¥ | Catalog
J New Database > X )
Project Portal Computer Favorites
CANADA & New Toolbox >
o .
Search Project
EE New Suitability Models ﬁ |
L ft, New Notebook - FPs
e P i@ Tdolboxes
Gz New Style
P &l Dptabases
S

les

Ha New ArcGIS Server | New Server > b 5 Fdlders

I-a New OGC API Server S New Cloud Storage Connection A9 Ldcators

=
|_E] New WCS Server > New STAC Connection

Hﬂ New WFS Server .;fq New BIM Cloud Connection
|_E] New WMS Server v
|-§ New WMTS Server New
. T + Add >
MEXICO
Import >

New Locator

2. Inthe dialog box, enter the Server URL: https://gispub.epa.gov/arcgis/services and click OK. A
username and password are not required.

Add ArcGIS Server Connection X

Server URL: https://gispub.epa.gov/arcgis/services
Authentication (Optional)

User Mame:

Password:

%) Save Username / Password to Windows Credential Manager

) Save Username / Password to connection file

oK ‘ | Cancel



https://www.epa.gov/rps
https://gispub.epa.gov/arcgis/services
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3. Anew “Servers” item will automatically be
added to the Catalog pane. Click the arrow 4 [@ Servers

next to the “MapServer on gispub.epa.gov” | » b [ MapServer on gispub.epa.gov.ags

server icon to display a list of folders.
I I Folders

P OSWER

4. Click the arrow next to the “OW” folder to
display a list of map services in the folder.

Rt ow

2 PrintTools

— 4| res
Indicator_Data

5. Click the arrow next to the “RPS” service

icon to display a list of layers in the RPS Map —
Service. Indicator_Info

NHDPlusV2_HUC12

NHDPlusV2_HUC12_Simplified
6. Right-click on the “NHDPlusV2_HUC12”

layer and click “Add to Current Map.” _l +  Add To Current M
o Lurren ap

+ add To MNew 3

The HUC12 Feature Layer will now appear in the Contents pane and HUC12s will display in the viewer
window. The symbology of HUC12s can be customized to display any indicator and HUC12s can be
filtered to only display HUC12s that meet user-defined selection criteria. Users can also run
geoprocessing tools on the HUC12 polygons to complete additional analysis.

Contents - x| [[E]Map ¥

T | Search R
00/ B&

Drawing Order

<[E]Map

4[] NHDPIusv2_HUC12
O

[9] Topagraphic
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4 Querying the RPS Map Service

Indicator data can be retrieved by querying the RPS Map Service. A query is a string of text that contains
user-supplied search parameters for retrieving data from a dataset. When a map service receives the
query, the data that meet the search parameters are identified and returned to the user. For example,
the HUCI12 Feature Layer can be queried to retrieve indicator data for any user-defined geographic area
of interest. The data returned by the query can then be used by application developers in desktop,
mobile, or web-based applications to visualize or analyze HUC12 conditions.

The base URLs for querying the layers and tables in the RPS Map Service are listed in Table 1. Users of
the RPS Map Service can develop custom queries to define their desired outputs and the format of
outputs. This section describes commonly used parameters for creating a custom query and example
queries. The ArcGIS reference page for querying a map service contains a full list of query parameters
that are available to map service users and descriptions of each parameter.

The example queries in this section return outputs in “html” format to facilitate viewing in a web
broswer. The output format is specified in the query with the Format parameter (f=html). Readers can
change the Format parameter to view alternative formatting options (for example, f=json will return the
results in JavaScript Object Notation (JSON) format).

Table 1. Base URLs for querying the layers and tables in the RPS Map Service.

Item Base URL

HUC12 Feature Layer https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query
Simplified HUC12 Feature | https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query
Layer

Indicator Data Table https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query
Indicator Information https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query
Table



https://developers.arcgis.com/rest/services-reference/enterprise/query-map-service-layer-.htm#GUID-BA3B02CD-BD10-4F19-BFB5-72A04D49D005
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query
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Table 2. Example query parameters for retrieving data from the HUC12 Feature Layer and Simplified HUC12 Feature Layer.

Query Description Example Queries
Parameter
Where A clause for filtering the HUC12 Query 1. Returns all indicators for a specific HUC12 ID. The HUC12 ID of interest is 020600040203. The
Feature Layer or Simplified HUC12 qguery uses the Where parameter and the “HUC12_TEXT” field of the attribute table to limit the
Feature Layer using the layer’s output to the single HUC12 of interest.
attribute table. Results are returned | Hyc12 Feature Layer:
for any HUC12s that meet the user- | https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?where=HUC12 TEXT='0206
specified criteria. 00040203'&outFields=*&f=html
Simplified HUC12 Feature Layer:
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?where=HUC12 TEXT='0206
00040203'&outFields=*&f=html
Input A geographic filter for the query. Query 2. Returns all indicators for a HUC12 that intersects a specific point location. The point is
Geometry & Results will only be returned for defined using the Input Geometry and Geometry Type parameters. The horizontal (x) coordinate of
Geometry HUC12s that meet the geographic the point is -8515000 meters and the vertical (y) coordinate of the point is 4720000 meters. The
Type filter. geographic coordinates are in the same coordinate system as the HUC12 Feature Layer.

HUC12 Feature Layer:
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?geometry=-
8515000,4720000&geometryType=esriGeometryPoint&outFields=*&f=html

Simplified HUC12 Feature Layer:
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?geometry=-
8515000,4720000&geometryType=esriGeometryPoint&outFields=*&f=html

Query 3. Returns all indicators for HUC12s that intersect a rectangular geographic area of interest.
The rectangular area is defined using the Input Geometry and Geometry Type parameters. The
coordinates of the rectangular area are:

e Minimum horizontal (xmin) coordinate = -8515000 meters

e  Minimum vertical (ymin) coordinate = 4720000 meters

e Maximum horizontal (xmax) coordinate = -8510000 meters

e Maximum vertical (ymax) coordinate = 4728000 meters
HUC12 Feature Layer:
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?geometry=-
8515000,4720000,-8510000,4728000&geometryType= esriGeometryEnvelope&outFields=*&f=html
Simplified HUC12 Feature Layer:
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?geometry=-
8515000,4720000,-8510000,4728000&geometryType= esriGeometryEnvelope&outFields=*&f=htm|



https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?where=HUC12_TEXT='020600040203'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?where=HUC12_TEXT='020600040203'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?where=HUC12_TEXT='020600040203'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?where=HUC12_TEXT='020600040203'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?geometry=-8515000,4720000&geometryType=esriGeometryPoint&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?geometry=-8515000,4720000&geometryType=esriGeometryPoint&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?geometry=-8515000,4720000&geometryType=esriGeometryPoint&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?geometry=-8515000,4720000&geometryType=esriGeometryPoint&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?geometry=-8515000,4720000,-8510000,4728000&geometryType=%20esriGeometryEnvelope&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?geometry=-8515000,4720000,-8510000,4728000&geometryType=%20esriGeometryEnvelope&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?geometry=-8515000,4720000,-8510000,4728000&geometryType=%20esriGeometryEnvelope&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?geometry=-8515000,4720000,-8510000,4728000&geometryType=%20esriGeometryEnvelope&outFields=*&f=html
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Out Fields

A list of fields from the attribute
table of the HUC12 Feature Layer or
Simplified HUC12 Feature Layer to
be included in the query results.
Using an asterisk (outFields=*) will
return all fields.

Query 4. Returns three indicator values for a specific HUC12 ID: the HUC12 name, percent impervious
cover and percent forest cover in the HUC12. The query uses the Out Fields parameter to limit the
output to the three indicators. The HUC12 ID of interest is 020600040203.

HUC12 Feature Layer:
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?where=HUC12 TEXT='0206
00040203'&outFields=NAME HUC12, IMP_COV PCT HUC12,FOREST PCT HUC12&f=html

Simplified HUC12 Feature Layer:
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?where=HUC12 TEXT='0206
00040203'&outFields=NAME HUC12, IMP_COV PCT HUC12,FOREST PCT HUC12&f=html



https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?where=HUC12_TEXT='020600040203'&outFields=NAME_HUC12,%20IMP_COV_PCT_HUC12,FOREST_PCT_HUC12&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/0/query?where=HUC12_TEXT='020600040203'&outFields=NAME_HUC12,%20IMP_COV_PCT_HUC12,FOREST_PCT_HUC12&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?where=HUC12_TEXT='020600040203'&outFields=NAME_HUC12,%20IMP_COV_PCT_HUC12,FOREST_PCT_HUC12&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/1/query?where=HUC12_TEXT='020600040203'&outFields=NAME_HUC12,%20IMP_COV_PCT_HUC12,FOREST_PCT_HUC12&f=html
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Table 3. Example query parameters for retrieving data from the Indicator Data Table.

Query Description Example Queries

Parameter

Where A clause for filtering the Indicator Data Query 5. Returns all indicators for a specific HUC12 ID. The HUC12 ID of interest is
Table. Results are returned for any 070900020702. The query uses the Where parameter and the “HUC12_TEXT” field to limit the
HUC12s that meet the user-specified output to the single HUC12 of interest.
criteria. https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=HUC12 TEXT

='070900020702'&outFields=*&f=html

Query 6. Returns all indicators for HUC12s in Wisconsin. The query uses the Where parameter
and the “STATE_MAJ” field to limit the output to HUC12s that have the majority of their area in
Wisconsin.

https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=STATE MAJO
RITY='WI'&outFields=*&f=html

Input Not used in queries of the Indicator Data Table. The Indicator Data Table is not linked to HUC12 polygons.

Geometry &

Geometry

Type

Out Fields A list of fields from the Indicator Data Query 7. Returns three indicator values for a specific HUC12 ID: the HUC12 name, the county

Table to be included in the query results. where the HUC12 is located and percent protected lands in the HUC12. The query uses the Out
Using an asterisk (outFields=*) will return | Fields parameter to limit the output to those three indicators. The HUC12 ID of interest is
all fields. 070900020702.

https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=HUC12 TEXT
='070900020702'&outFields=NAME HUC12, COUNTY MAJORITY HUC12,
PROT LAND PCT HUC12&f=html

Query 8. Returns HUC12 IDs in the contiguous US with at least 75% natural land cover. The
query uses the Out Fields parameter to limit the output to the HUC12 ID and percent natural
land cover fields. The Where parameter is used to limit the output to HUC12s with at least 75%
natural land cover.

https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=N INDEX PC
T HUC12>75&outFields=HUC12 TEXT,N INDEX PCT HUC12&f=html



https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=HUC12_TEXT='070900020702'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=HUC12_TEXT='070900020702'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=STATE_MAJORITY='WI'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=STATE_MAJORITY='WI'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=HUC12_TEXT='070900020702'&outFields=NAME_HUC12,%20COUNTY_MAJORITY_HUC12,%20PROT_LAND_PCT_HUC12&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=HUC12_TEXT='070900020702'&outFields=NAME_HUC12,%20COUNTY_MAJORITY_HUC12,%20PROT_LAND_PCT_HUC12&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=HUC12_TEXT='070900020702'&outFields=NAME_HUC12,%20COUNTY_MAJORITY_HUC12,%20PROT_LAND_PCT_HUC12&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=N_INDEX_PCT_HUC12%3e75&outFields=HUC12_TEXT,N_INDEX_PCT_HUC12&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/2/query?where=N_INDEX_PCT_HUC12%3e75&outFields=HUC12_TEXT,N_INDEX_PCT_HUC12&f=html
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Table 4. Example query parameters for retrieving data from the Indicator Information Table.

Query Description Example Queries
Parameter
Where A clause for filtering the Indicator Query 9. Returns the entire Indicator Information Table. The query uses the Where parameter
Information Table. Results are returned and the “OBJECTID” field to return all rows.
for any indicators that meet the user- https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=0BJECTID>0
specified criteria. &outFields=*&f=html
Query 10. Returns all columns for a specific indicator of interest: road density in the HUC12.
The query uses the Where parameter and the “Field_Name” column to limit the output to the
road density indicator.
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=Field Name=
'ROADS ALL DENSITY HUC12'&outFields=*&f=html
Query 11. Returns all columns for indicators in the “Ecological” category. The query uses the
Where parameter and the “Category” column to limit the output to Ecological indicators.
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=CATEGORY="'
Ecological'&outFields=*&f=html
Input Not used in queries of the Indicator Information Table. The Indicator Information Table is not linked to HUC12 polygons.
Geometry &
Geometry
Type
Out Fields A list of fields from the Indicator Query 12. Returns indicator names and descriptions for all indicators. The query uses the Out

Information Table to be included in the
query results. Using an asterisk
(outFields=*) will return all fields.

Fields parameter to limit the output to the name and description fields.

https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=0OBJECTID>0
&outFields=Indicator Name,Description&f=html

Query 13. Returns indicator names and descriptions for indicators in the “Forest Cover”
subcategory. The query uses the Out Fields parameter to limit the output to the name and
description fields. The Where parameter is used to limit the output to indicators in the Forest
Cover subcategory.

https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=SUBCATEGO
RY='Forest Cover'&outFields=Indicator Name,Description&f=html



https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=OBJECTID%3e0&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=OBJECTID%3e0&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=Field_Name='ROADS_ALL_DENSITY_HUC12'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=Field_Name='ROADS_ALL_DENSITY_HUC12'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=CATEGORY='Ecological'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=CATEGORY='Ecological'&outFields=*&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=OBJECTID%3e0&outFields=Indicator_Name,Description&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=OBJECTID%3e0&outFields=Indicator_Name,Description&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=SUBCATEGORY='Forest%20Cover'&outFields=Indicator_Name,Description&f=html
https://gispub.epa.gov/arcgis/rest/services/OW/RPS/MapServer/3/query?where=SUBCATEGORY='Forest%20Cover'&outFields=Indicator_Name,Description&f=html
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